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Photoshop World 2021 
Getting Organized in Lightroom Classic 
By Rob Sylvan 

 
A place for everything and everything in its place is a phrase often attributed to Benjamin Franklin, but 
can absolutely apply to how we use Lightroom Classic. One of the keys to getting organized in Lightroom 
Classic is understanding all the components of a typical workflow, what tools exist to help us stay 
organized, and then developing habits that allow us to use those tools consistently in a manner that 
scales successfully into the future. Join Rob as he demonstrates the features and functions within 
Lightroom Classic to help you organize your photo library and manage the associated settings and files 
to keep your workflow running smoothly. 
 

As I’ve worked with people over the years, I’ve noticed a few common obstacles to getting their 
Lightroom Classic (LrC) lives more organized, so my approach to this article is to address ways 
to overcome these issues to help anyone struggling to feel more in control of their growing 
photo libraries. I’ve also embedded links to related articles I’ve written and one of Scott’s 
classes to help you go even further. 
 
One of the first obstacles to overcome is understanding what all the components of a LrC 
workflow are so that we can manage them over time. From there, the next hurdle is knowing 
what organizational tools are available within LrC, and then how to use them. Once people 
understand the components and the tools, then they can apply them effectively and continue 
to refine their workflows to become more consistent and efficient. Once you’ve reached that 
stage of progress you are in control of your photo library, and that’s the place I want to help 
everyone reach.  
 
What about a specific organizational system? I’ve had the pleasure of seeing a lot of different 
ways photographers organize their photos and some methods work really well, and some are a 
horrible, disorganized mess. The three important elements of a successful organizational 
system appear to be that the system must make sense to the way that person’s brain works, it 
must scale smoothly into the future as the library grows, and the user must be able to easily 
find the photos they are looking for when needed. Outside of that, there’s a lot of room for 
creativity. So, while I will share some of my thoughts on what works for my brain, I recognize 
that it might not work for yours, so if you have a system that meets the above criteria (like 
Scott’s SLIM system) then I feel you would get more out of focusing on improving efficiencies 
within your system than changing the system completely. 
 

The Components 

The key components of a LrC workflow that you need to keep in mind are your photos, the 
catalog (and its associated files), and the presets/templates you use to become more efficient. 
You also need to understand how these files interact and depend on each other to avoid self-
inflicted injury. A firm grasp of each component will put you on the right track to staying 
organized. Let’s explore each of these components in a bit more detail. 

https://members.kelbyone.com/course/skelby-2019-lightroom-slim-system/
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Your Photos 

The whole reason you’re doing this is for your photos, and they must be at the center of all 
your decisions. You must know where your photos are located on your system, have them 
included in a backup process, and have a plan for managing them over time as you outgrow 
your current hardware. The place to find them in LrC is the Folders panel in the Library module. 

 
There are two main places where LrC 
touches your actual photos, with the 
first being part of the import process 
and the second being through 
managing them in the Library 
module. During the import process 
you have an opportunity to decide 
where the photos will be stored, and 
after import, in the Library module 
you will find the tools to rename, 
move, delete, keyword, organize into 
collections, and find your photos 
over time. You must have a plan for 
how you will use these tools to keep 
your library organized and 
understand how to use each of these 
tools. We’ll revisit these tools a little 
later. 
 
The Catalog 

At its heart (or brain?) LrC has a 
database, called the catalog, that 
stores information about every 
photo (and video) that goes through 
the import process.  
 
The main job of the import process is 
to create a new database record for 
each photo that includes all the 
metadata created by the camera, the 
exact location (path) to where that 

photo is stored on your system, and any additional metadata you add along the way (like 
copyright and contact information). You can find where your catalog is located by going to 
Lightroom Classic > Catalog Settings > General (PC: Edit > Catalog Settings > General). 



 3 

 
 
Each time you launch LrC you are opening that database and looking at its contents. All the 
work you do in LrC (every keyword, color label, collection membership, virtual copy, edit, etc.) 
is written to that database as you do the work in real time. By default, LrC does not write any of 
that information to your photos at all. For these reasons you can see that it is very important to 
know where your catalog is located, keep it backed up, and know how to restore from disaster 
if something happens to your catalog file. Clicking the Show button (above) opens your file 
browser to the folder containing your catalog (below). 
 

 
 
Stored alongside the catalog (which has a .lrcat file extension) are several files that protect it 
from being opened by another program while you have it open, assist it in case of a crash, and 
store previews of each photo that is being managed by that catalog (called a cache). Together, 
this collection of files allows you to work with your photos even if they are stored on an offline 
drive because LrC spends most of its time writing to the catalog and showing you previews of 
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your photos. Your actual photos are never in LrC, but always stored in some folder on some 
drive on your system that LrC simply references via the path stored in the catalog. 
 
Presets and Templates 

The words presets and templates get used 
interchangeably within LrC, but whatever you call them 
they are crucial to a consistent and efficient workflow. 
 
LrC’s original reason for existing was to provide a more 
efficient workflow for digital photographers, and there 
are many points within a workflow, from import to 
export (and everything in between) that you can 
leverage presets and templates to make your life easier.  
 
The most common example are the presets we use in the 
Develop module, but you can create import presets, 
filename templates, metadata templates, text templates, 
and export presets too. Keeping these files updated, 
organized, and under control (especially Develop 
presets) are important considerations to managing your 
photo library over a lifetime. 
 
Now that you’re familiar with the components let’s dive 
into the most important organizational tools LrC has to 
offer. 
 

Organizational Tools 

The Develop module is the sexy beast everyone likes to spend time in, but the Library module is 
the most important place for keeping your photo library under control and for finding the 
photos you want when you need them. I include the import process as part of the Library 
because that is your first opportunity to keep yourself organized and moving in the right 
direction, so let’s start there.  
 
The Import Window 

Earlier I stated that the main job of the import process was creating records in the catalog file 
about each imported photo, but the secondary job of importing can involve copying or moving 
photos to a storage location of your choosing. You need to be in the driver’s seat for this job 
and ensure that LrC is not placing photos in an undesired location. There are two choices on the 
import window that determine where your photos will end up. The first choice is along the top 
of the screen where you choose between Copy as DNG, Copy, Move, or Add.  
 

https://lightroomkillertips.com/managing-develop-presets-in-lightroom-classic/
https://lightroomkillertips.com/managing-develop-presets-in-lightroom-classic/
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The two most common choices are Copy and Add. If your photos are coming from a memory 
card you will choose Copy (Copy as DNG is effectively the same as Copy except it also includes 
the operation to convert the raw photos to DNG, but for organization purposes it is beyond the 
scope of this article). If your photos are already exactly where you want them to be stored 
(because you put them there outside of LrC), then you will choose Add.  
 

A word about Move. I don’t recommend using Move for safety 
reasons because Move includes a copy operation followed by a 
delete operation from the original location. It is much safer to 
use Copy for import, and then once the copy operation is done 
successfully you can go and manually delete the source files 
from the original drive if that is what is needed. Move will be 
unavailable when the source is a memory card, so it would 
only come into play when source photos are on a hard drive. 
 
When choosing Copy the only other choice you need to make 
at this time is in the Destination panel. When Add is selected 
the photos are already in their final location, so the Destination 
panel is not included. 
 
When configuring the options in the Destination panel you 
have two choices to make. The first is where do you want the 
photos to be stored and the second is how do you want them 
to be organized at that location. Keeping in mind that the 
settings in the Import window apply to ALL photos being 
imported at this time you want to choose a location that works 
for all photos being imported. The default setting in the 
Organize drop-down menu at the top of the panel is By date, 
which includes options for 
your choice of date format in 
the drop-down menu below 
it.  
 
The nice things about the By 
date organize option is that it 
is fully automated using the 
creation date of each photo 
to create corresponding folders within the folder selected in 
the Destination panel and it scales nicely into the future. That 
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said, dates alone may not give you enough information to find your photos easily in the future. I 
work around this limitation by simply renaming the date-based folders after import (using the 
Folders panel) to include additional meaningful information along with the date. This way I 
don’t have to think about organizing my photos during the Import window, can let the 
automation of folder creation save me time, and get the benefit of dates added to each folder 
so that they sort in a meaningful way within the Folders panel.  
 
All that said, if your system utilizes the Into one folder option in the Organize drop-down menu, 
and that works for your brain, then don’t let me stop you from using that option. I recognize 
the benefits of putting your photos in custom named folders from the outset, and I know many 
who use that option. If it isn’t broken, don’t fix it. 
 
Additionally, I recommend standardizing on the top-level location for all newly imported 
photos. In my case, I copy all new photos to a folder structure within the Pictures folder of my 
internal drive with the same top-level parent folder selected for all imports (and let LrC create 
the subfolders within it). This way I don’t have to spend any time thinking about where to put 
photos at this time, and best of all, can create an import preset that includes the settings in the 
Destination panel (as well as all the panels above it). Over time, I use the Folders panel to move 
folders to a larger external drive to maintain space on the internal drive. 
 

 
 
To create an import preset, configure all desired import settings (in all panels), then click the 
Import Preset drop-down menu at the very bottom of the screen and choose Save Current 
Settings as New Preset. You can create as many of these import presets as your workflow 
requires. These are huge time savers and allow for consistency in your organizational efforts 
(check out my Photoshop World session on Optimizing Lightroom Classic for more on this idea). 
For each subsequent import job, simply choose your desired import preset and everything is 
done. After a quick visual confirmation all you need to do is click the Import button and LrC 
does the rest. 
 

The Library Module 
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Once the import process begins your view returns to the Library, and as the photos fill your 
screen you can turn your attention to the Folders panel to confirm the photos are going exactly 
where you designated. The Folders panel is one of the most powerful tools for organizing your 
photos over time. It is here that you can move folders into new folders and drives, rename 
folders, remove folders, create subfolders and more. For example, I mentioned that I rename 
all newly created folders during import to include a meaningful name in addition to the date. 
Here’s how to do this: 
 
Step One: Right-click the folder you want to rename. 
 
Step Two: Choose Rename from the contextual menu. 
 
Step Three: Enter a meaningful name in the Rename Folder dialog box that appears and click 
Save.  
 

 
 
This renames the folder in the Folders panel as well as on your drive all in one move while 
keeping the record in the catalog up to date. By performing all your file management tasks in 
LrC you keep your files organized and keep the catalog updated. To learn even more about the 
Folders panel and how to unlock all of its power, be sure to bookmark my article on the Role of 
the Folders panel. 
  
A powerful benefit to naming your folders with simple, descriptive, and consistent names is 
that you can utilize the filter at the top of the Folders panel to quickly find all the folders that 

https://lightroomkillertips.com/understanding-role-folders-panel-part-1/
https://lightroomkillertips.com/understanding-role-folders-panel-part-1/
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match what you type in that field, even across 
multiple drives. This works with both numbers 
and names, so if I wanted to see only folders 
from 2021 I can just type that in the filter and 
display only the folders that match. Likewise, if I 
wanted to find all folders containing photos 
from Yosemite, I just type that in the field and I 
don’t need to remember when I was there at all. 
 
The key is to be consistent when naming folders 
so you can get consistent results from the filter. 
This same trick works in the Library Filter bar for 
finding photos based on the names you gave the 
containing folder.  
 
Here’s how to do it: 
 
Step One: Click All Photographs in the Catalog 
panel so the entire library is searched and press 

G for Grid view if not there already. 
 
Step Two: Click the Text button on the Library Filter to open the text input field. 
 
Step Three: Type the text you want to search on into the field. In my case I typed Yosemite here 
too. 
 

 
 
Your entire library is now searched for that word in all searchable fields, which includes folder 
names. In this screen capture you can see the folder name displayed on the thumbnail. I find 
this much faster and simpler than keywording each individual photo. I’ve got nothing against 
keywording in general if it is needed for a given workflow, but in my experience, it is a non-
preferred activity for most people (to put it mildly). If keywording is your thing, then take a dive 
into my controlling keywords article to learn more about them, and by all means keep using 
them. Let’s take a closer look at the power of these filters. 
 
The word “filter” often gets used to describe the edits and adjustments made to our photos, 
but in LrC the real meaning has to do with how you can filter the data stored in the catalog to 

https://lightroomkillertips.com/controlling-keywords/
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help you in your workflow. We’ll start with the most obvious, but there’s more hidden here and 
there within the Library module. 
 
The Library Filter Bar 

Located above Grid view in the Library module, the Library Filter bar is the most powerful and 
useful filtering tool in Lightroom. The key to using the filter is understanding that it only filters 
the currently selected source, whether that is folders, collections, or your entire catalog. You 
select the source first, then apply the desired filter to see the results. 
 

 
 
The Library filter consists of four parts, a filter by text function (Text), a filter by photos’ 
attributes (Attribute), a filter by photo’s metadata (Metadata), and a drop-down menu for 
accessing saved Library Filter presets. The Text, Attribute, and Metadata sections can be used 
independently or in conjunction with each other. 
 
The best way to learn how to use these is to explore and try out the various options, but before 
doing that there are a couple of 
keyboard shortcuts you should file away 
to keep you out of trouble. The first is 
CMD+L (PC: Ctrl+L) which will turn on or 
turn off the Library Filter, so if you are 
playing around and want to escape the 
filter simply employ that shortcut and 
you’re back to the unfiltered view. The 
second is the backslash (\) key which 
hides and reveals the Library Filter bar 
itself. This is useful when using the 
Library Filter and you want to hide it to 
see more of your photos, but I’ve seen it 
cause frustration when people hit that 
key by accident and can’t find the filter bar. Here’s a bonus tip, in any module press CMD+/ (PC: 
Ctrl+/) or go to Help > [ModuleName] Shortcuts menu to display common keyboard shortcuts 
for the module you are in, and then click anywhere on the overlay to dismiss it. 
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Text-based Filters 

I just showed you how you can use the Text filter to find photos based on folder names, but 
another example of one that I use frequently is a text-based filter to find HDR photos based on 
filename. Here’s how: 
 
Step One: Select the desired source containing the photos you want to filter. In my example I 
selected All Photographs in the Catalog panel to filter the entire library. 
 
Step Two: Press CMD+F (PC: Ctrl+F) to open the Text filter with the search field active for text 
input. This will also switch to Grid view if not there already. 
 
Step Three: Type in the text you want to filter the results on. In my case I typed HDR because 
LrC automatically adds those letters to the filenames of all merged HDR photos it creates, as 
does the HDR mode in the Lightroom mobile camera module. As soon as you start typing the 
filter starts working in real time. 
 

 
 
Step Four: Refine the filter. By default, that filter is set to Any Searchable Field, which may cast 
the net wider than you intend. Click the (tiny) drop-down arrow next to the magnifying glass 
icon in that text field and choose Filename (for my example) to force the filter to only use photo 
filenames. You can achieve the same result by clicking the drop-down where it says Any 
Searchable Field and changing it there. The same goes for changing the Contains All option to 
something that better fits your needs. 
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Pretty cool? I most often use that when working in a folder full of brackets that I am merging to 
HDR. After setting all the various brackets to be merged I enable the filter so that I only see the 
final results in the folder for processing further. When finished, press CMD+L (PC: Ctrl+L) to 
disable the filter. 
 
Attributes 

In the course of your workflow you may apply color labels (learn how to make the most of 
them), flags, or star ratings, and eventually you will edit some (or all) of the photos. 
Additionally, you may have a mix of photos and videos, and perhaps even some virtual copies. 
All of these aspects can be used as filters under the Attribute button on the Library Filter.  
 

 
 
One of the most useful ways I’ve found for this is when making my initial selects after returning 
from a shoot. I’m a big fan of using Flags to mark the keepers from the ones headed to the 
trash. Here’s what I do: 
 
Step One: Select the desired source to filter and press G for Grid view. 
 

Step Two: Click the Attribute button to 
expand its options, then right-click the Flag 
section to access the contextual menu. 
Select Flagged and Unflagged. Assuming 
you have not yet applied any flags, there 
should be no change in what photos are 
being shown. 
 
Step Three: Begin the process of applying 
Flags. Make sure Auto Advance is checked 
under the Photo menu. As I mentioned 
previously, use P for picks, X for rejects, 
and U for unflag. Because of the filter that 
is set any photos marked as Reject will be 
hidden from view. When you reach the 
last photo in the shoot you will only see 

picks and unflagged. 

https://lightroomkillertips.com/making-the-most-of-color-labels-in-lightroom-classic-part-1/
https://lightroomkillertips.com/making-the-most-of-color-labels-in-lightroom-classic-part-1/
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Step Four: Right-click the Flag section and choose Unflagged Photos only. Now picks and rejects 
are hidden and only the ones you skipped are visible. Repeat the process again using only pick 
or reject until all are hidden from view. 
 
Step Five: Set the filter to Rejected Photos Only and make sure there were no accidental 
rejections. Change if needed. 
 
Disable the filter to see all the photos and delete the rejects or use the filter to keep the rejects 
hidden and move on to processing. Explore all the other ways you can turbo-charge your 
workflow with this filter. 
 
One note of caution, at the end of the Attribute filter is the Kind section. If you hover your 
cursor over each icon, you’ll see what they represent. If you ever get a weird filter result that 
doesn’t make sense double-check that one of these Kind icons is not accidentally included in 
the filter. I have seen that virtual copy icon get enabled by accident (somehow) and it can be 
easy to miss. 
 
Metadata 

The most powerful aspect of the 
Library Filter is the Metadata section 
simply because there is so much more 
data available to filter on. Once 
enabled you’ll likely see the default set 
of metadata columns. If you place your 
cursor over the label on any column, 
you’ll see it become active and drop-
down arrows appear. Click that label to 
access a different set of data for that 
column. 
 
On the right-side of the column is 
another drop-down menu where you 
can access controls for removing a 
column, adding a new column, and 
changing the way the data in the 
column is displayed or sorted. You can have as many as 8 columns or as few as just a single 
column. 
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Customizing these columns to your needs is where the real power lies, and once you’ve created 
a set of columns to your 
specifications click the 
Preset drop-down menu 
at the far-right of the 
Library Filter and choose 
Save Current Settings as 
New Preset. Give that 
preset a meaningful name 
and you’ll be able to recall 

it anytime in the future from that same Preset drop-down menu or under the Library > Filter by 
Preset menu (note the other filter options buried in that Library menu too). You can also create 
saved presets based on Text, Attribute, or any combination of filters too. 
 
Bonus tip! Place your cursor over the bottom edge of the Library Filter when Metadata is 
enabled, and you’ll see it change to a double-sided arrow. Click and drag up or down to change 
the height of the columns. Remember that the \ key hides and shows the Filter bar without 
disabling the filter to better see the photo results. 
 
Filmstrip Filter 

All of these filters can also be accessed right from the Filmstrip while you are in any of the other 
modules. Way over on the top-right side of the Filmstrip is the Filter section. Click the word 
Filter to expand the options (a second click will collapse them). The drop-down menu there 
gives you access to all the same filter presets as up in the Library Filter. The little light switch at 
the end turns the filters on or off. Don’t forget you can even change sources from the Filmstrip 
by clicking the path displaying the current source. 
 

 
 
Locked and Unlocked 

There are times when I want to apply the same filter to more than one source when I am 
gathering up photos for a project. The little lock icon at the end of the Filter bar will lock the 
current filter as you change sources when the lock is closed. When the lock is open you have to 
manually enable the filter if you change sources. 
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Did you know it is possible to lock a unique filter 
to different sources? It may be kind of an edge-
use case, but it is there if you ever have the 
need. Let’s say you wanted to filter one folder 
on all photos that are 4 star and above, and 
another folder for all photos with a pick flag so 

that you could switch back and forth between sources without having to change the filter each 
time.  
 
Here’s how: 
 
Step One: Select the first source and set the 4 star and above Attribute filter, then click the Lock 
icon. 
 
Step Two: Go to File > Library Filters, and check Remember Each Source’s Filters Separately. 
 
Step Three: Switch to the second source and set the pick flag only Attribute filter. 
 
Step Four: Switch back and forth between sources and you should see a unique filter applied to 
each one. 
 
Clicking the lock icon again to unlock the filter will disable the unique filters when you are done 
with the project. File that away for the future. 
 
Things You Can Mark as Favorites in Lightroom Classic 

Like whiskers on kittens, bright copper kettles, and warm woolen mittens, it turns out there are 
a number of things you can mark as a “favorite” inside of LrC. The core logic around why you 
would mark something as a favorite is that it is something you use often and want to have 
faster access to it again in the future. 
 
Favorite Folders 

If you’ve got a folder or two that you’d like ready access to from anywhere in Lightroom, 
consider marking them as a favorite. This process was made much easier in a recent update. 
Simply right-click a folder and choose Mark Favorite (you can unmark as favorite the same way). 
 
That folder will gain a special star icon to identify it as a favorite. If you click the drop-down 
menu in the folder filter field (say that five times fast), you’ll see there is an option to filter by 
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favorites as well. When selected you’ll 
only see folders that have been marked 
as favorites in the Folders panel. A 
great way to clear the clutter when 
needed. 
 
Folders marked as favorites will also 
appear as a favorite source via the 
breadcrumbs link in the Filmstrip, 
which we’ll look at next. 
 
 
 

Favorite Sources 

While there isn’t the same functionality for collections as the previously mentioned 
functionality for folders (don’t ask me why), there is a way to do it. Here’s how: 
 
Step One: Select the collection you want to add to favorite sources. 
 
Step Two: Click the breadcrumbs path in the Filmstrip to open its menu. 
 
Step Three: Click Add to Favorites at the bottom of the list. 
 

 
The collection, or source, will be added to the Favorite Source section of the menu. Collections 
marked as favorites don’t get the same fancy icon as folders do, so the only place to see which 
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have been marked as a favorite is in this menu. You can also remove a selected source from this 
list from the same breadcrumbs menu. 
 
Filter Within Panels – Going Deeper 

Earlier I showed you the little search field at the 
top of the Folders panel, but a similar filter also 
exists in the Collections, and Keyword List panels 
too. They are easy to ignore and overlook, but each 
is wonderful tool for filtering the contents of each 
panel respectively. I have hundreds of folders, 
nearly as many collections, and thousands of 
keywords. Instead of clicking and scrolling through 
each of those panels to find what I am looking for I 
can just type a few letters and the contents of each 
panel is filtered in real time! This is a huge time 
saver. 
 
That little drop-down menu in each of the panels holds the real goodies so be sure to try each 
one. Did you know you can filter the Collections panel by color labels as well, or to only display 
synced collections? You can! And the Keyword List panel can be filtered to just show People 
keywords if you use face recognition. Filtering data is one of the most useful things you can do 
in a database (catalog), so get out there and try all these little gems to see how they can help 
make your workflow more efficient.  
 

Mastering Collections  

A key piece of data stored in the LrC catalog is the location of each imported photo on your 
system, stored as a path, from the volume name (PC: drive letter) to the individual file name 
and all the folders in between (this is part of what we see in the Folders panel). This allows LrC 
to reference where each photo is stored, and when needed for working in Develop or exporting 
copies, the program can access the photo in question and do the job at hand. Because LrC only 
references each photo, it can leverage that data to easily group photos together in a variety of 
ways using these things called collections. Think of collections as virtual folders that only exist 
within the catalog. 
 
Some people find it easier to think of collections like musical playlists in a music app, where you 
can create a playlist and add as many songs to it as you wish, and you know that the music app 
is only referring to each song file without regard to where that song file is stored on your 
computer. Likewise, you can have an infinite number of playlists and you can even add the 
same song to every playlist, and at no time does the music app duplicate the actual song file on 
your computer or move it to a different location. Collections behave exactly the same way. This 
makes collections an incredibly powerful tool for organizing and accessing your photos beyond 
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the physical storage aspect of folders. Collections can be found in the Catalog panel and in the 
Collections panel. 
 
The Catalog Panel 

Before we get to the aptly named Collections panel, I want to point out that LrC comes pre-
loaded with a few useful collections in the Catalog panel. 
 

 
 
Even if you have a completely empty catalog, you’ll find the All Photographs, All Synced 
Photographs, Quick Collection, and Previous Import collections ready to go. As photos are 
imported into the catalog you will see the number next to All Photographs increase accordingly, 
and clicking on that collection will give you access to all imported photos at once. If you are 
using LrC and are syncing with Lr on your mobile devices, the All Synced Photographs collection 
gives you a running tally on the number of photos synced, and provides similar easy access to 
them. 
 
The Quick Collection is for when you need to temporarily gather a group of photos together 
and hold them while you work, which can be useful for pulling together some photos to be 
printed, exported, or some other purpose. You can add a photo to the Quick Collection by 
dragging and dropping it onto the Quick Collection, and you can remove a photo by selecting it 
and pressing the Delete (PC: Return) key. By default, the Quick Collection is also set as the 
Target Collection, denoted by the small + sign next to it in the Catalog panel. As the Target 
Collection, you can also add photos to it by selecting them and pressing the B key, or by clicking 
the small gray circle button that appears in the upper-right corner of the thumbnail. 
 
Conversely, you can remove photos from the Target Collection by pressing the B key or clicking 
that button while viewing the collection.  
 
The Previous Import (will say Current during an active import) will always show the last batch of 
photos to go through the import process (or the current active import). By default, when you 
start an import the current view will switch to this collection and you’ll see the new photos 
appear in the catalog. If you don’t wish to switch to viewing this collection during an import you 
can go to Preferences > General and uncheck Select the Current/Previous Import collection 
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during import, and you will remain viewing whichever folder or collection you were in before 
the import started. 
 
Other collections may also appear in the Catalog panel as you work over time. These can be 
created when you do things such as export a catalog or use the Find Missing Photos command 
(found under the Library menu). If you discover one of these collections, such as this Previous 
Export as Catalog collection, and you want to remove it, just right-click it to access the 
contextual menu for removal. 
 

 
 
 
While those pre-built collections in the Catalog panel are all very useful in their own way there 
is another level of user-driven collections that you can leverage to fit your organizational needs. 
This is where the Collections panel comes into play. 
 
The Collections Panel 

There are three types of collection tools found here: 

• Collection Sets – used for providing organizational structure 

• Collections – used for manually gathering up photos in various groupings 

• Smart Collections – a type of saved search that automatically finds photos matching 
specific criteria 

 
Collection sets can only contain collections, smart collections, or other collection sets, which is 
why they are good for creating structure within the Collections panel. For example, you might 
have a collection set called Travel, and then within that collection set you could create a 
collection set for each location you’ve traveled to, and then within each location’s collection set 
you’d create collections and/or smart collections to gather up the relevant photos for each 
location. 
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Because LrC is always referencing the photos, you can continue to add photos to existing 
collections without worrying about where those photos are stored on your system. This also 
gives you the ability to add photos to as many collections as you need to without worry of 
duplicating photos on your drive. So, I can have photos in my All Yosemite Photos collection 
(and keep adding more each time I visit) as well as those same photos in each respective 
collection based on a location within the park. In the future, if I need to find a photo from 
Yosemite, I can just go to this collection set and find them without needing to remember what 
folder those photos happen to be stored within on my system. I can then use the Library Filter 
bar to refine the view of any given collection to show photos by date, rating, flag, camera, lens, 
and so on. This is truly leveraging the power of that catalog (database) for my needs. 
 
There are a few different ways to create these collection tools, with the most obvious being the 
+ sign at the top of the Collections panel. 
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From this menu you can choose which tool you need, and then you’ll be presented with the 
dialog box for completing the process. Each tool has different options, so let’s look at each one 
in turn. I’ll create a collection set for a trip to Montana, and then create a collection to hold all 
of the photos from the trip, and then a smart collection to automatically gather up my highest 
rated photos from that collection. This process can be applied to any combination of collection 
sets, collections, and smart collections. 
 
STEP ONE: Click the + sign at the top of the Collections panel and choose Collection Set. 
 
STEP TWO: Give the collection set a name, and choose if you want it to be placed within an 
existing collection set. In my case, I want it to go into my Travel collection set, so that is 
checked. 



 21 

 
 
Click Create to add it to the Collections panel. 
 
Now that I have my parent collection set I can begin to add collections and smart collections to 
organize my photos. First I’ll add a collection for all photos from the trip to Glacier National 
Park. 
 
STEP ONE: An alternative to the + sign at the top of the panel is to right-click the parent 
collection set and choose Create Collection from the contextual menu that appears. 
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STEP TWO: When the Create Collection dialog appears the Location will already be configured 
for inside the Montana collection set. I can now give this collection a name and click Create to 
add it to the panel. 
  
Adding Photos 

Now I’m ready to add photos to that collection, and this can be done simply by dragging and 
dropping the photos from Grid view to the collection. As an alternative, if you want to create a 
collection from an entire folder of photos you can drag and drop the folder from the Folders 
panel to the Collections panel. 
 
Either option gives the same result, but when you drag the folder down the resulting collection 
will have the same name as the folder. To rename a collection, just right-click and choose 
Rename from the contextual menu that appears. 
 
Now that I have a collection set, and my first collection, I can create a smart collection with a 
few simple rules to automatically find all of the photos I give a high star rating. 
 
STEP ONE: Right-click the Montana collection set and choose Create Smart Collection from the 
contextual menu. 
 
STEP TWO: In the resulting Create Smart Collection dialog box, give the smart collection a name 
and note that it is already configured to be created within the parent collection set. 
 
STEP THREE: Define your first rule. For this smart collection I want a rule based on the star 
rating. By default, the Rating criteria came up as my first rule, so I just need to define the 
criteria and the number of stars. I chose greater than or equal to 4 stars. 
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STEP FOUR: Add additional rules as needed. I also want a rule that defines the source of the 
photos being searched or else the default behavior is to apply the rules to all photos in the 
catalog. Click the + sign at the end of the first rule to add a second. Then click the rule drop-
down menu to choose from the available options. Under Source, I chose Collection, and then 
entered the name of the collection I had just created. Click Create to put it into action. 
 

 
 
With my greater than or equal to 4 stars and All Glacier Photos collection set as the source, as I 
apply a 4 or 5 star rating to any photos in that collection they will automatically be gathered 
into my new smart collection. With the knowledge to create smart collections you can design 
your own Catalog Dashboard to help you keep tabs on your growing photo library. With these 
basic concepts mastered and put into practice you’ll be well on your way to being organized 
and can then take it up a notch with becoming more efficient over time. 
 

Please don’t hesitate to reach out to me with any questions. You can find me at any of the 
following locations: 
 
Twitter: @Lightroomers 
Facebook: @Sylvanworks 
Instagram: @Sylvanworks 
Web: RobSylvan.com  
 

https://lightroomkillertips.com/complete-catalog-dashboard/
https://twitter.com/lightroomers
https://www.facebook.com/Sylvanworks/
https://www.instagram.com/sylvanworks/
https://robsylvan.com/

